
DEPARTAMENTO DE CIENCIAS FORENSES
ORGANISMO DE INVESTIGACIÓN JUDICIAL (OIJ)

PODER JUDICIAL, COSTA RICA

PROCEDIMIENTO DE
OPERACIÓN NORMADO

ESPECÍFICO

Gestión de indicios de imagen
y sonido mediante QuickDME P-DCF-ECT-ISF-24

VERSIÓN: 02 Rige desde: 29/10/2021 PÁGINA:  1 de 7

Elaborado o modificado por:  Revisado por Líder Técnico:

Bach. Mariela Quirós Villegas
Fotógrafa Forense

Bach. Maureen Rojas Brenes
Líder Técnico de Sección

Licda. Laura Guerra Vargas
Técnica en Video Forense

Bach. Federico Sáenz Rodríguez
Líder Técnico de Sección

Visto Bueno Encargado de Calidad: Aprobado por:

Lic. José Alfonso Rodríguez Arias Lic. Marco Herrera Charraun
Encargado de Calidad de la Sección de

Imagen y Sonido Forense
Jefe, Sección Imagen y Sonido Forense

CONTROL DE CAMBIOS A LA DOCUMENTACIÓN

Versión Fecha de
aprobación

Fecha de
revisión

Descripción del cambio SCD Solicitado
por

01 18/12/2018 29/10/2021 Versión inicial del procedimiento
002-SCD-
ISF-2018

RVF

02 29/10/2021 - Actualización general del proceso.
Inclusión PhotoEvidence Pro.

004-SCD-
ISF-2021

MHC

ESTE PROCEDIMIENTO ES UN DOCUMENTO CONFIDENCIAL
PARA USO INTERNO DEL DEPARTAMENTO DE CIENCIAS FORENSES

SE PROHÍBE CUALQUIER REPRODUCCIÓN QUE NO SEA PARA ESTE FIN

La versión oficial digital es la que se mantiene en la ubicación que la Unidad de Gestión de
Calidad defina. La versión oficial impresa es la que se encuentra en la Unidad de Gestión de

Calidad. Cualquier otro documento impreso o digital será considerado como copia no controlada.

COPIA N
O C

ONTROLA
DA



DEPARTAMENTO DE CIENCIAS FORENSES VERSIÓN: 02 PÁGINA: 2 de 7

Gestión de indicios de imagen
y sonido mediante QuickDME

P-DCF-ECT-ISF-24

1 Objetivo:

Unificar la manera en que el personal técnico y pericial de la Sección de Imagen y Sonido Forense
del Departamento de Ciencias Forenses realiza la gestión del material original resultante de sus
servicios  de  documentación.  Para  dicha  gestión  utilizará  el  servidor  de  evidencia  digital  y  el
conjunto de aplicaciones llamado “QuickDME”, compuesta por:

a) “QuickDownloader” es la aplicación encargada de la incorporación  de material al  servidor de
evidencia digital.

b)  “AccessDME” es  la  aplicación dedicada a la  visualización,  administración,  copia,  anotación,
quema  de  discos  e  impresión  de  los  indicios  que  han  sido  incorporados  previamente.  Es  la
herramienta que llevará el control de cadena de custodia de los indicios durante estas fases. A su
vez, el AccessDME es la vía para la incorporación de las versiones del material ya procesado que
se han preparado para la entrega al usuario final.

2 Alcance:

Este procedimiento tiene que ser aplicado por el  personal  técnico y  pericial de la  Sección de
Imagen y  Sonido  Forense  del  Departamento  de  Ciencias  Forenses  al  momento  de  realizar  la
inclusión de evidencia, administración y uso de la misma.

El servidor de evidencia digital y QuickDME se podrá utilizar también para almacenar los indicios
remitidos para análisis solicitados a las unidades periciales. También podrán utilizar este servidor
para  almacenar  el  material  resultante  de  sus  pericias.  Las  instrucciones  se  detallan  en  los
correspondientes procedimientos específicos.

El QuickDME lleva un estricto control de cadena de custodia. Por ello evite navegar en casos fuera
de aquellos que sean del estricto interés de las órdenes de trabajo que le han sido asignadas.

3 Referencias:

• Ocean Systems. QuickDownloader Getting Started Guide. Ocean Systems Support. 2019.
• Ocean Systems. AccessDME Getting Started Guide. Ocean Systems Support. 2021.

4 Equipos y materiales:

• Cable USB para conexión de cámara.
• Discos ópticos para (CD-R, DVD-R, BD-R). Excluir medios regrabables.
• Lector de tarjetas.
• Ordenador con acceso a SADCF.
• Quemador de discos ópticos interno o externo para CD-R, DVD-R y BD-R. 
• Software QuickDME.

5 Reactivos y materiales de referencia:

No aplica.

6 Condiciones ambientales:

No aplica.

7 Procedimiento:

7.1 Incorporación de indicios con QuickDownloader:
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7.1.1 Inserte la tarjeta de memoria, disco o memoria USB en la computadora. 

7.1.2 Inicie la herramienta QuickDownloader para incorporar el material. Para ello utilice su ícono
que encontrará en la barra de tareas y seleccionando la opción “Browse...”

Nota 1: Si no aparece el icono en la barra de tareas debe iniciarlo de manera manual.  Vaya a
“Inicio>Todos los programas\Ocean Systems\QuickDME\QuickDownloader”.

La  aplicación  QuickDownloader  está  también  disponible  dentro  del  menú  “File>Add  original
evidence” dentro de la aplicación AccessDME.

7.1.3 Señale la carpeta que contiene el material.

7.1.4 Subida de casos individuales:

7.1.4.1 Si  el  dispositivo  contiene  imágenes  de  un  único  caso  seleccione  “Subida  de  caso
individual”.

7.1.4.2 Seleccione en la ventana “Selección y prevista de contenido” los indicios que desea
incorporar al caso.

7.1.4.3 Complete los campos del recuadro “Información del caso”:

• Número  Único:  Si  la  solicitud  presenta  número  único,  utilice  el  formato  ##-######-
####-??, ejemplo 18-000001-0042-PE. Si se trata de una destrucción de droga o prueba
de  chalecos  que  no  cuentan  con  número  único,  mantenga  el  formato  ##-######-
####-?? sustituyendo el número único por el número de orden de trabajo, por ejemplo 00-
002018-1795-IS.

• Autoridad Judicial: Indique el nombre completo oficial del despacho solicitante, por ejemplo
“Clínica Médico Forense”  o  “Subdelegación Regional  de Cañas”.  Guíese con el  listado en
SADCF.

7.1.4.4 Complete los campos del recuadro “Información de ítemes subidos”

• Sitio  de  toma:  Esta  casilla  se  llena  automáticamente  con  la  información  de  la  ventana
“Autoridad Judicial”, usted debe corregir indicando la información del sitio de toma.

• Tomado/Procesado por: Escriba el nombre de la persona que tomó el material.
• Fecha: Seleccione la fecha en que se tomó el material.
• Hora: Escriba la hora inicial de toma del material (formato hora militar, ejemplo 1400).
• Subido por: Indique su usuario.
• Contraseña: Anote su contraseña.
• Orden de trabajo (AAAA-#####-ISF): Escriba el número de orden de trabajo, mantenga el

formato. Ejemplo 2018-00001-ISF.
• Persona solicitante: Anote el nombre completo de la persona que solicitó el servicio.

7.1.4.5 Elija las opciones adicionales al proceso de subida (solo si combinación de usuario y
contraseña es correcta se habilitan las opciones adicionales)

• “Etiquetar  los  items seleccionados”:  permitirá  realizar  el  etiquetado de los  archivos.  Ver
procedimientos específicos para instrucciones de etiquetado según el servicio.

• “Preservar  estructura  de  carpetas”:  permitirá  mantener  la  distribución  de  carpetas  y
subcarpetas existente en el sitio de origen.

• “Hacer copia local”: permitirá de manera paralela a la subida realizar un duplicado del material
en  el  computador  como  copia  de  trabajo.  Considere  que  cualquier  otra  copia  que  ocupe
realizarse  en etapas  posteriores  a  la  subida  inicial  del  caso  deberá  realizarse  mediante  el
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AccessDME para dejar constancia de la justificación.

7.1.4.6 Cuando esté listo seleccione “Iniciar subida”.

7.1.5 Subida de caso múltiple:

7.1.5.1 Si el dispositivo contiene material de varios casos utilice “Subida de caso múltiple”.

7.1.5.2 Seleccione aquellos indicios que corresponden al primer caso.

7.1.5.3 Complete  los  cuadros de “Información del  caso” e  “Información de ítemes subidos”
como se muestra en los puntos 7.1.4.3 y 7.1.4.4.

7.1.5.4 Al finalizar, seleccione el botón “Añadir a la cola”.

7.1.5.5 Repita los puntos 7.1.5.2 al 7.1.5.4 para todos los demás casos. Una lista de los casos
se mostrará en la parte inferior “Download Queue” de la ventana.

7.1.5.6 Cuando esté listo seleccione “Iniciar subida”.

7.2 Etiquetado de archivos mediante la funcionalidad “Evidence Tag”:

Nota 2: Solo algunos servicios requieren esta etapa de etiquetado. Ver procedimientos específicos
para instrucciones de etiquetado según el servicio.

7.2.1 Anote en el espacio en blanco ubicado en la parte superior el texto de la etiqueta de cada
uno de los indicios. Presione “Enter” para avanzar al siguiente ítem.

7.2.2 Seleccione  la  opción  “Sensitive”  en  la  parte  superior  para  marcar  las  imágenes  con
contenido explícito, particularmente desnudez o menores de edad. Con esta opción habilitada se
evita que se muestren miniaturas en los reportes.

7.2.3 Seleccione “Enter” o “Close” para finalizar el proceso de etiquetado cuando haya alcanzado
el último ítem.

7.3 Administración de indicios con AccessDME

7.3.1 Inicie la aplicación AccessDME e ingrese su usuario y contraseña.

7.3.2 Localice el caso de interés utilizando el panel “Search tool”.

Nota 3: Para todas las órdenes de trabajo atendidas antes del 2018 refiérase al punto 7.4.

7.3.3 Elija en el desplegable el campo que utilizará como método de búsqueda. El programa
permite localizar el  material  utilizando cualquiera valores de los campos que se ingresaron al
momento de la subida.

7.3.4 Ingrese el dato que conozca  del caso de interés. Puede utilizar operadores de búsqueda
como los siguientes:

Seleccione un operador de búsqueda de los siguientes:

• “*1234” retornará una lista de todos los casos que terminan en “1234”
• “APD2014-*” retornará una lista de todos los casos que inician en “APD2014-*”
• “*2014*” retornará todos los casos que tengan “2014” en alguna parte de su nombre.

7.3.5 Una vez que ingrese el dato (o la parte conocida combinada con comodines) haga clic en el
botón “Find”.  Los resultados de una búsqueda retornarán el listado de casos que concuerden.
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Serán mostrados en carpetas. Dentro de éstas serán visibles como subcarpetas cada uno de los
eventos de descarga en los que se hayan asociado nuevos indicios a ese número de caso. Estas
subcarpetas son descritas con algunos datos básicos para identificarlos. Típicamente fecha, autor
y número identificador de descarga (“DownloadID”).

7.3.6 De la lista de resultados elija el caso de interés para realizar cualesquiera de las tareas que
corresponda, a saber: (consulte el detalle de los pasos en el manual de AccessDME)

• Visualización de material y corrección de campos de información  : verifique que el material y
la  información proporcionada  en el  recuadro  “Información Caso”  o  “Download Info”  sea
correcta,  de  lo  contrario  proceda a  corregirla  y  presione  el  botón  “Save  changes”  para
finalizar..

• Etiquetado  : si se requiere complementar o corregir el etiquetado realizado al momento de la
subida inicie la funcionalidad “Evidence Tag” localizada en el menú “Edit >Edit Tags...” y siga
los pasos del punto 7.2.

• Generación  de  reporte  hash  :  Ingrese  a  “Menú>Reports>Tag...” Seleccione  la  impresora
Microsoft Print to PDF. Elija “Print”.  Ingrese el nombre del archivo de la siguiente manera:
“Reporte  QDME_AAAA-#####-ISF”  (número  de  OT)  y  seleccione  la  ubicación  para  el
documento. Este reporte debe incluirse al legajo del caso en el SADCF como un anexo de
tipo “Reporte generado por software”.

• Copia  : para realizar copias de material almacenado en el servidor de evidencia digital utilice
la opción “File>Copy” del menú principal. Es obligatorio llenar el campo “Release To:” en que
se justificará el motivo y/o destinatario. Si es para un destinatario externo a la ISF active la
opción “Include Hash Report” para incluir el listado cálculo hash de las imágenes exportadas.
Seleccione “OK”.

• Impresión  : elija la opción correspondiente del menú principal. Es obligatorio llenar el campo
“Release To:” en que se justificará el motivo y/o destinatario.

• Quema en disco  : elija la opción correspondiente del menú principal. Es obligatorio llenar el
campo  “Release  To:”  en  que  se  justificará  el  motivo  y/o  destinatario.  Active  la  opción
“Include Hash Report” para incluir  el  listado cálculo  hash de las imágenes exportadas y
seleccione “OK”.

• Agregar derivativos  : Organice el material que subirá dentro de una única carpeta que lleve
como nombre el número único (se admite el uso subcarpetas para organizar el material).
Seleccione  en el  menú principal  “File>Add a  derivative...”.  En la  ventana  de  elección y
descripción del material a incorporar, rellene los espacios de la siguiente manera:

 Derived from: seleccione el download id correspondiente a la carpeta de donde se
derivó el material.

 Derivative Notes: anote la descripción “Material procesado”, “Material de trabajo” o
similar según corresponda.

 Tomado/Procesado por: seleccione el usuario que preparó las imágenes derivativas.
 Fecha de colecta: Fecha en que se terminó de procesar el material.
 Hora de colecta: Hora en que se terminó de procesar el material.
 Subido por: seleccione su usuario de AccessDME.
 Orden de trabajo (AAAA-#####-ISF): Número de OT, se debe mantener el formato.

Ejemplo 2018-00001-ISF.
 Persona solicitante: anotar el nombre completo.

7.4 Acceso a casos importados de PhotoEvidence Pro:

Nota 4: Los casos están organizados usando como clave principal el número único. De ese modo
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hay números únicos que tienen dentro varias órdenes de trabajo.

Los casos se incorporaron al QuickDME grupalmente. Se hicieron conjuntos anuales usando como
clave el año del número único. Nótese que no es el año de la orden de trabajo que dicta su
agrupación; por ejemplo, un caso con orden de trabajo 2018 podría estar ubicado en el grupo de
2016 si el número único corresponde a ese año.

En cada grupo anual encontrarán una carpeta adicional que contiene una tabla con los datos
básicos del caso y las fotos en formato ODS (para Calc de Libre Office).

Esa carpeta también incluye el archivo de base de datos nativo del PhotoEvidence Pro (formato
compatible con Microsoft Access). Ahí está disponible toda la información que en su momento fue
recabada por ese sistema. Se adjuntó un programa que permite acceder al contenido de ésta.

Cada año también incluye una subida adicional de fotografías complementarias correspondiente a
las pruebas de chalecos ya que estas no tienen un número único.

Es importante tomar en cuenta que una búsqueda por número único o nombre de la foto no dará
resultados. Porque el AccessDME no realiza búsquedas de subcarpetas.

7.4.1 Para la búsqueda y  proceso de órdenes de trabajo procedentes de Photo Evidence Pro
ingrese en el  campo de búsqueda de número único los  valores “*-EV”.  A partir  de ahí  debe
localizar manualmente las fotografías de interés.

7.4.2 Cambie la vista del panel “Items” a modo “Tree”.

7.4.3 Realice las tareas indicadas en la solicitud siguiendo los pasos en el punto 7.3.6

7.5 Solicitud de correcciones de casos en AccessDME:

7.5.1 Redacte un correo electrónico a la persona administradora del QuickDME, con copia al jefe
de  sección,  para  solicitar  la  “purga”  (eliminar)  del  material  que  se  ha  ingresado  de  manera
errónea. El correo debe contener la siguiente información:

• Número único.
• Orden de trabajo.
• Download ID.
• Motivo por el cual se debe eliminar el material.

8 Criterios de aceptación o rechazo de resultados:

No Aplica.

9 Cálculos y evaluación de la incertidumbre:

No Aplica.

10 Reporte de análisis y resultados:

No Aplica.

11 Medidas de seguridad y salud ocupacional:

No Aplica.
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12 Simbología:

SADCF: Sistema Automatizado Departamento de Ciencias Forenses.

13 Terminología:

QuickDME: Conjunto de aplicaciones forenses para la gestión de evidencia digital, por sus siglas
en inglés “Digital Media Evidence”.

14 Anexos

No aplica.
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